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Introduction

This document describes how to interact with the IBM® Cognos® TM1® on Cloud
system, the related components, and the common modeling tasks. As a modeler for
your cloud system, this document helps you understand the steps and features
that are unique to the cloud environment.

Because the Cognos TM1 on Cloud system operates in a remote hosted
environment, this document explains how to remotely interact with and connect to
the cloud system. The document also provides an overview of the cloud system
and how to work with multiple cloud environments.

Information and steps are provided about the following tasks:
v How to run each of the programs that are provided with the cloud system.
v How to move files between your local computer and the cloud system.
v How to connect to the cloud system with a remote desktop session.

This document does not contain detailed information about each of the Cognos
TM1 programs that are provided with the Cognos TM1 on Cloud system. Instead,
a brief description of how each program works with the cloud system is provided
along with links to the related documentation for these other programs.

Audience

To use this guide, you should be familiar with the following concepts:
v Your Cognos TM1 data and modeling requirements
v Cognos TM1 user security options and capabilities
v Basic Microsoft Windows file management
v Remote file management using secure file transfer protocol (FTPS) tools
v Remote system access using remote desktop protocol (RDP) tools

Finding information

To find IBM Cognos product documentation on the web, including all translated
documentation, access one of the IBM Cognos Information Centers
(http://pic.dhe.ibm.com/infocenter/cogic/v1r0m0/index.jsp). Release Notes are
published directly to Information Centers, and include links to the latest technotes
and APARs.

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. Some of the
components in the IBM Cognos TM1 on Cloud system have accessibility features.
For information on these features, see the accessibility section in the documentation
for each of the IBM Cognos components included in the Cognos TM1 on Cloud
system.

IBM Cognos HTML documentation has accessibility features. PDF documents are
supplemental and, as such, include no added accessibility features.

© Copyright IBM Corp. 2007, 2014 v
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Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any
variation of the Sample Outdoors or Great Outdoors names, and Planning Sample
depict fictitious business operations with sample data used to develop sample
applications for IBM and IBM customers. These fictitious records include sample
data for sales transactions, product distribution, finance, and human resources.
Any resemblance to actual names, addresses, contact numbers, or transaction
values is coincidental. Other sample files may contain fictional data manually or
machine generated, factual data compiled from academic or public sources, or data
used with permission of the copyright holder, for use as sample data to develop
sample applications. Product names referenced may be the trademarks of their
respective owners. Unauthorized duplication is prohibited.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.
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Chapter 1. Getting started with Cognos TM1 on Cloud

Modelers for IBM Cognos TM1 on Cloud should understand the overall cloud
system and how it is different from a standard Cognos TM1 installation. They
must understand how to connect to the cloud system and provide this information
to other users. They must also be familiar with the available components and
ensure that users have the required connection information and operating
instructions to run the available components.

Cognos TM1 on Cloud overview
As a Cognos TM1 modeler, you should understand your IBM Cognos TM1 on
Cloud environment and how the different components work together.

Cognos TM1 on Cloud non-production and production
environments

A typical IBM Cognos TM1 on Cloud solution includes two separate cloud
environments or systems: one for non-production and one for production
purposes. You receive a separate set of account information for each environment.

For example, you can use the non-production environment for development
purposes and the production environment as your live environment.

As a Cognos TM1 modeler, you use a remote desktop connection from your local
computer to connect to either cloud system. After you connect to a cloud system,
you can run the applications that are hosted on that system.

You can move files between your local computer and the shared folder on either
cloud system. You can also move files between the shared folders of different cloud
systems.

Figure 1. Example of IBM Cognos TM1 on Cloud non-production and production
environments
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Cognos TM1 on Cloud system
IBM Cognos TM1 on Cloud provides a Cognos TM1 environment hosted on a
secure, remote system that you and your users can access. Each cloud system
supports a collection of Cognos TM1 desktop, web-based, and mobile applications
for end users and modelers. Each system also includes a shared folder for storing
and accessing your data files.

The Cognos TM1 on Cloud system includes the following main components:
v Cognos TM1 Server
v Cognos TM1 hosted and local applications
v Cloud system shared folder

The following figure provides an overview of the different components and
applications that make up a typical Cognos TM1 on Cloud system. The interaction
between the Cognos TM1 server, hosted applications, local applications, and shared
folder are shown.

User access

Cognos TM1 on Cloud modelers have user accounts that let them connect directly
to the cloud system using a remote desktop protocol (RDP) connection or a secure
file transfer protocol (FTPS) application. This enables modelers to run the related
Cognos TM1 desktop programs and to manage files in the shared folder on the
cloud system.

Typical non-modeler users connect to the cloud system using only the web, mobile,
and local Cognos applications. Typical users do not connect to the cloud system
using RDP or FTPS.

Cloud operating system

The Cognos TM1 on Cloud system runs on the Microsoft Windows Server 2012
operating system. This Windows system runs the Cognos TM1 server and hosts
instances of the available Cognos TM1 web-based and desktop-based programs.

Figure 2. IBM Cognos TM1 on Cloud system overview
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Cognos TM1 Admin Server and Cognos TM1 Server

Your cloud system uses the following default names for the IBM Cognos TM1
Admin Host and Cognos TM1 Server:
v Default Cognos TM1 Admin Host name: data
v Default Cognos TM1 Server name: tm1

Cognos TM1 on Cloud applications and components
IBM Cognos TM1 on Cloud includes a collection of components for monitoring,
modeling, analyzing, and interacting with Cognos TM1 data. These components
are either hosted on the cloud system or installed directly on your local computer
or mobile device. All of the components connect to the Cognos TM1 Server that
runs on the cloud system.

For information on running each of these components, see Chapter 2, “Running
Cognos TM1 components with Cognos TM1 on Cloud,” on page 13.

Hosted applications

The cloud system computer hosts Cognos TM1 programs that are accessed either
from a web browser or by remote desktop connection.

The following web-based applications run on the Cognos TM1 on Cloud system.
You access these applications using a web browser on your local computer.
v IBM Cognos TM1 Web
v IBM Cognos TM1 Applications
v IBM Cognos TM1 Operations Console

The following desktop applications run on the Cognos TM1 on Cloud system. You
access these applications with a remote desktop connection to the cloud system
that uses the remote desktop protocol (RDP).
v IBM Cognos TM1 Perspectives
v IBM Cognos TM1 Architect
v IBM Cognos TM1 Performance Modeler
v IBM Cognos Insight (Connected mode)

Note: Cognos Insight runs only in Connected mode when you run it in the
remote desktop session of the cloud system. Running Cognos Insight in the
remote desktop session is intended only for modelers performing workspace
layout design.

Local applications

The following IBM Cognos programs are installed and run directly on your local
computer and remotely access the Cognos TM1 Server on the cloud system:
v IBM Cognos Insight (Distributed mode)

Note: Cognos Insight runs only in Distributed mode when you run it on your
local computer and remotely access the Cognos TM1 server on the cloud system.

v IBM Cognos Analysis for Microsoft Excel
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Mobile applications

Mobile users can run IBM Cognos TM1 Mobile Contributor on their Apple iPad
tablet and remotely connect to the Cognos TM1 Server on the cloud system.

Cognos TM1 on Cloud shared folder
The IBM Cognos TM1 on Cloud system provides a dedicated shared folder for
your Cognos TM1 data and related files.

The shared folder is accessible only with the shared folder user name, password,
and addresses that were provided in the Cloud Welcome Kit.

Shared folder content

The shared folder contains the following files:
v Cognos TM1 data and log files
v Transfer archive files from IBM Cognos TM1 Performance Modeler
v Transfer specification files from IBM Cognos TM1 Performance Modeler
v Other files and documents that you want to use with your Cognos TM1 on

Cloud system

Accessing the shared folder

You can use your shared folder account user name and password to access the
shared folder in the following ways:
v Use the Windows File Explorer in the remote desktop session to manage files in

the shared folder.
v Use a secure file transfer protocol (FTPS) application on your local computer to

move files between your local computer and the shared folder.

Important: To ensure that your data is encrypted when transferred, the cloud
system FTP connection is configured to use FTP with Secure Sockets Layer
(FTPS). Make sure to use an FTP application that supports FTPS.

v If you have multiple cloud environments, you can use File Explorer to move
files between the shared folders in each environment.

For detailed steps about accessing your shared folder, see “Managing files in the
Cognos TM1 on Cloud shared folder” on page 24.

Data backup for the shared folder

The files in the shared folder are backed up on regular basis. Check with IBM
Support for more information.

Cognos TM1 on Cloud account and system information
The IBM Cognos TM1 on Cloud system is managed and accessed through a group
of dedicated user accounts and system addresses that are assigned to your
company or organization.

When you first use your cloud system, you are provided with a Cloud Welcome
Kit file for each cloud system you requested. This file contains a set of account and
system information that is unique for your cloud system. The information includes
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the main user account credentials, system addresses, and URLs that you use to
connect to one specific Cognos TM1 on Cloud system.

Note: The information in the Cloud Welcome Kit supersedes the online
documentation where there are any differences or questions.

The file for the Cloud Welcome Kit uses the following naming format:

wwwX.cognostm1.ibmcloud.com Cloud Welcome Kit date.txt

The X is a unique identification number for that specific Cognos TM1 on Cloud
system.

Important: Keep this information in a safe place. The provided user accounts are
only for modelers who need remote desktop and file transfer access to the cloud
system.

A typical Cognos TM1 on Cloud system includes the following account and system
information:

Cognos TM1 on Cloud system address
The unique system address for your Cognos TM1 on Cloud system. Use
this information for remote desktop access to your cloud system.

Typical format:

wwwX.cognostm1.ibmcloud.com

Where X is a unique identification number for one of your Cognos TM1 on
Cloud systems.

You typically have more than one cloud system address. For example, you
might have addresses for non-production and production cloud
environments.

User account names and passwords
Each cloud system includes multiple user accounts.

Remote desktop user account:
User name and password for your remote Microsoft Windows user
account.

Use this account when you run a remote desktop session on the
cloud system. For example, you use a remote desktop session to
run the hosted desktop-based programs such as IBM Cognos TM1
Performance Modeler and IBM Cognos TM1 Architect.

The user names for this account use the format modeler1, modeler2
to modelerX. Depending on your exact cloud system, you might
have one or more of these user accounts.

Important: This user account is only for Cognos TM1 modelers,
and not for standard users of Cognos TM1.

Cognos TM1 Server admin account:
User name and password for the primary Cognos TM1
administrator account.

Use this account to log in to Cognos TM1 Performance Modeler or
Cognos TM1 Architect to create other Cognos TM1 user accounts.
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For more information, see “Managing Cognos TM1 user accounts
with Cognos TM1 on Cloud” on page 23.

You can also use this account to log in to any of the Cognos TM1
user interfaces.

Important: This user account is only for Cognos TM1 modelers,
and not for standard users of Cognos TM1.

Cognos Command Center account:
User name and password for Cognos Command Center.

Use this account to log in to Cognos Command Center to work
with agents. For more information, see “Cognos TM1 on Cloud
with Cognos Command Center agents” on page 20.

The Cloud Welcome Kit contains other information that you can
use to work with Cognos Command Center.

Shared folder account:
User name and password for secure file transfer protocol (FTPS)
and Windows file sharing with the shared folder on your cloud
system.

Cognos TM1 desktop applications
Use this information for remote desktop access to Cognos TM1
Performance Modeler, Cognos TM1 Architect, Cognos TM1 Perspectives,
and Cognos Insight (in connected mode).

For example, use a Microsoft Windows Remote Desktop Connection with
the following format to remotely connect to your cloud system:

wwwX.cognostm1.ibmcloud.com

Where X is a unique identification number for one of your Cognos TM1 on
Cloud systems.

Note: If you are prompted when starting Cognos TM1 Performance
Modeler, make sure the IBM Cognos TM1 system URL field contains the
following URL:

https://wwwX.cognostm1.ibmcloud.com/pmpsvc/services

URLs for Cognos TM1 web-browser-based applications
You can provide these URLs to your users so they can access the related
Cognos TM1 web-based applications from their web browsers.
v IBM Cognos TM1 Web

https://wwwX.cognostm1.ibmcloud.com/tm1web/

v IBM Cognos TM1 Applications
https://wwwX.cognostm1.ibmcloud.com/pmpsvc/

v IBM Cognos TM1 Operations Console
https://wwwX.cognostm1.ibmcloud.com/pmhub/pm/opsconsole/

URLs for Cognos TM1 web-connected applications
Use this information to configure a remote data connection for the
following applications.
v IBM Cognos Analysis for Microsoft Excel

https://wwwX.cognostm1.ibmcloud.com

v IBM Cognos TM1 Mobile Contributor
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– Host: wwwX.cognostm1.ibmcloud.com
– Port: 443
– Enable SSL: Set this option to ON to use Secure Sockets Layer (SSL)

security with the connection.

Shared folder information
User account information for secure file transfer protocol (FTPS) and
Windows file sharing with the shared folder on your cloud system. This
information includes user name, password, and addresses assigned to your
shared folder.

For detailed steps about accessing your shared folder, see “Managing files
in the Cognos TM1 on Cloud shared folder” on page 24.

Connecting to Cognos TM1 on Cloud with a remote desktop
connection

Use a remote desktop connection to connect to the IBM Cognos TM1 on Cloud
system so you can run the hosted desktop-based applications or manage files in
the shared folder. For example, you can start a remote desktop connection and
then run IBM Cognos TM1 Architect, IBM Cognos TM1 Perspectives, and IBM
Cognos TM1 Performance Modeler.

Before you begin

Cognos TM1 on Cloud is configured to support only secure remote desktop
protocol (RDP) connections.

To successfully connect to a Cognos TM1 on Cloud desktop session you need to
use a remote desktop protocol (RDP) application that supports Network Level
Authentication (NLA). RDP applications are available for both Microsoft Windows
and non-Windows platforms.

For example, you can use the built-in Remote Desktop Connection feature in
Microsoft Windows 7, Vista, and XP. For more information about this feature,
search the Microsoft web site for “Connect to another computer using Remote
Desktop Connection”.

To verify that your version of Windows Remote Desktop Connection supports
Network Level Authentication, perform the following steps:
1. Open the Remote Desktop Connection tool.

This tool is typically located here: Start menu > All Programs > Accessories >
Remote Desktop Connection.

2. In the Remote Desktop Connection window, click the program icon in the top
left corner of the window and then click About.

3. Verify that the following text is listed: Network Level Authentication
supported.

Procedure
1. Open your RDP application.

For example, to open the Windows Remote Desktop Connection tool, click Start
menu > All Programs > Accessories > Remote Desktop Connection.

2. Enter your Cognos TM1 on Cloud account information in the RDP application:
v Enter the address for your cloud system.
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For example:
wwwX.cognostm1.ibmcloud.com

Where X is your unique identification number for your cloud system.
v Enter your user name and password for your Windows remote desktop

account on the cloud system. For example, modelerX.

Tip: Some RDP applications might prompt you for a password only at
connection time.

3. Configure your RDP application to run Windows key combinations on the
remote computer.
This option sends your keyboard shortcuts for the Windows logo key and other
key combinations to the remote computer and runs them there.
For example, to configure this option in the Windows Remote Desktop
Connection tool:
a. Click Options > Local Resources tab.
b. Under the Keyboard section, set the Apply Windows key combinations

option to On the remote computer.
4. After all your information is entered and configured, use your RDP application

to start the remote desktop connection.
If the connection is successful, the desktop of the cloud system is displayed.

Tip: If the newer Windows Start menu desktop displays instead of the classic
desktop view, click the Desktop icon or press the Windows logo key to toggle
to the classic desktop view.

What to do next

After you successfully connect to a Cognos TM1 on Cloud desktop session you can
then run the hosted desktop applications and manage files in the shared folder.

Cognos TM1 on Cloud and Windows Server 2012
The IBM Cognos TM1 on Cloud system runs on the Microsoft Windows Server
2012 operating system. You interact with the Windows Server 2012 user interface
when you connect to the Cognos TM1 on Cloud system with a remote desktop
connection.

As a modeler for Cognos TM1 on Cloud, you should understand the Windows
Server 2012 user interface and some basic keyboard shortcuts. Knowing these
features will help you when you work in the remote desktop session on the cloud
system.

Windows Updates

IBM Support manages and applies updates to the Windows operating system of
your cloud environment.

Attention: When you use the remote desktop session on your cloud system, do
not try to run the Windows Update feature even if prompted.
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Windows Server 2012 user interface

Microsoft Windows Server 2012 has a user interface that is similar to the UI in
Microsoft Windows 8. The Cognos TM1 on Cloud system can display either the
new UI or the classic Windows desktop view. When you connect to the system
with a remote desktop connection, you can switch between these desktop views.

The shortcuts to open the hosted Cognos TM1 desktop applications are available
only in the classic Windows desktop view. Use the Windows logo key to switch
between the classic desktop view and the new desktop view.

You can find out more about Windows Server 2012 by searching the internet for
the following phrases:
v “common management tasks and navigation in Windows Server 2012”
v “ebook introducing Windows Server 2012 microsoft press RTM Edition”
v “keyboard shortcuts Windows Server 2012”

Windows Server 2012 basic keyboard shortcuts

You can use the following basic keyboard shortcuts for Windows Server 2012.

Tip: To make sure that your keyboard shortcuts are run on the cloud system
computer, configure your remote desktop connection to apply Windows key
combinations on the remote computer. For more information, see “Connecting to
Cognos TM1 on Cloud with a remote desktop connection” on page 7.

Windows logo key
Toggles between the classic Windows desktop view and the new Windows
desktop view.

Remember: The shortcuts to open the hosted Cognos TM1 desktop
applications are available only in the classic Windows desktop view.

Windows logo key + d
Minimizes all running programs and displays only the classic Windows
desktop. Press these keys a second time to toggle back to your running
programs.

Windows logo key + q
Displays the general search tool.

Windows logo key + f
Displays the file search tool.

Cognos TM1 on Cloud language configuration
You can configure the user interface language for the Cognos TM1 programs that
are provided with Cognos TM1 on Cloud. These programs can be configured to
use the same languages as the standard version of Cognos TM1.

Make sure that the language that you select is one of the supported languages for
Cognos TM1 listed the topic Cognos TM1 language codes (http://
pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/topic/
com.ibm.swg.ba.cognos.tm1_inst.10.2.0.doc/c_tm1_inst_tm1languagecodes.html).

Language for cloud-hosted desktop programs
You configure the user interface language for the desktop programs that
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are hosted in the cloud remote desktop session by using the Microsoft
Windows Control Panel > Language > Add a language option.

This configuration applies to the following programs:
v Cognos TM1 Perspectives
v Cognos TM1 Architect
v Cognos TM1 Performance Modeler
v Cognos Insight (Connected mode)

Language for cloud-hosted web browser-based programs
You configure the user interface language for web-based programs by
changing the language option in your web browser.

This configuration applies to the following programs:
v Cognos TM1 Web
v Cognos TM1 Applications
v Cognos TM1 Operations Console

Language for local programs
To change the user interface language for the programs that you run on
your local computer, use the Windows Language options.

This configuration applies to the following programs:
v Cognos Insight (Distributed mode)
v Cognos Analysis for Microsoft Excel

Language for mobile applications
To configure the language for the Cognos TM1 Mobile Contributor app,
you use the Apple iOS language settings on your iPad.

Configuring and accessing documentation with Cognos TM1 on Cloud
You can access Cognos TM1 documentation on the Cognos TM1 information center
using a web browser, or directly from the Help menu in any of the TM1
components. If you would like to access Cognos TM1 documentation from within
the cloud remote desktop session, you must configure the remote web browser to
include the documentation locations as trusted sites.

To correctly display Cognos TM1 documentation within the remote desktop session
of the cloud system, configure the Microsoft Internet Explorer web browser on the
cloud system.
1. On the cloud system, open Microsoft Internet Explorer.
2. Click Tools > Internet Options and then click the Security tab.
3. Add the location for the Cognos TM1 Performance Modeler Help system.

a. Click Local intranet and then click the Sites button.
b. Click Add and enter http://127.0.0.1

c. Click Close.
4. Add the base URL for the IBM Cognos TM1 Information Center:

a. Click Trusted sites and then click the Sites button.
b. Click Add and enter http://pic.dhe.ibm.com

c. Click Close.
5. Click OK to close the Internet Options dialog box.
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Accessing documentation on the IBM Cognos TM1 information
center

You can use the IBM Cognos TM1 online information center to access all of the
available TM1 documentation.

IBM Cognos TM1 10.2.0 Information Center (http://pic.dhe.ibm.com/infocenter/
ctm1/v10r2m0/index.jsp).
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Chapter 2. Running Cognos TM1 components with Cognos
TM1 on Cloud

As a modeler, you should understand how to run the IBM Cognos TM1
components that are available with IBM Cognos TM1 on Cloud.

Cognos TM1 on Cloud with Cognos TM1 Web
Cognos TM1 Web is hosted on the cloud system and runs in a web browser on
your local computer.

To run Cognos TM1 Web, you must know the related URL from the Cloud
Welcome Kit and have a valid Cognos TM1 user account.
1. On your local computer, open a web browser and enter the URL that was

provided for Cognos TM1 Web.
For example, Cognos TM1 Web uses the following URL format:
https://wwwX.cognostm1.ibmcloud.com/tm1web/

Where X is your unique identification number for your cloud system.
2. Enter the required information on the login page.

v For TM1 Server, use the default value of tm1.
v For User Name and Password, enter a valid Cognos TM1 user account.

As a modeler, you can enter the Cognos TM1 user account that is provided
in the Cloud Welcome Kit.
As a standard user, enter your assigned Cognos TM1 user account.

3. Click Login.

Cognos TM1 Web documentation

The following documentation for Cognos TM1 Web is available on the IBM Cognos
TM1 10.2.0 Information Center:

IBM Cognos TM1 Web User Guide (http://pic.dhe.ibm.com/infocenter/ctm1/
v10r2m0/topic/com.ibm.swg.ba.cognos.tm1_wb.10.2.0.doc/
c_tm1_wb_pref_intro.html).

Cognos TM1 on Cloud with Cognos TM1 Applications
Use a web browser on your local computer to run Cognos TM1 Applications with
your cloud system.
1. On your local computer, open a web browser and enter the URL for Cognos

TM1 Applications.
For example, Cognos TM1 Applications uses the following URL format:
https://wwwX.cognostm1.ibmcloud.com/pmpsvc/

Where X is your unique identification number for your cloud system.
2. Enter the required information on the login page.

For User Name and Password, enter a valid Cognos TM1 user account.
3. Click Login.
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Cognos TM1 Applications documentation

The following documentation for Cognos TM1 Applications is available on the IBM
Cognos TM1 10.2.0 Information Center:

IBM Cognos TM1 Applications Guide (http://pic.dhe.ibm.com/infocenter/ctm1/
v10r2m0/topic/com.ibm.swg.ba.cognos.tm1_cont_ug.10.2.0.doc/
c_planning_analytics_user_guide.html#planning_analytics_user_guide).

Cognos TM1 on Cloud with Cognos TM1 Operations Console
You can run IBM Cognos TM1 Operations Console from the web browser on your
local computer to monitor your IBM Cognos TM1 server in your IBM Cognos TM1
on Cloud system.

By default, Cognos TM1 Operations Console monitors the default Cognos TM1
server named tm1 on your cloud system. This server is also used for user and
group authentication when logging into Cognos TM1 Operations Console.

Default configuration for Cognos TM1 Operations Console

Cognos TM1 Operations Console uses the following configuration on your cloud
system:
v admin host: data
v Cognos TM1 server: tm1
v Cognos TM1 group for authentication: admin
v Cognos TM1 user account: admin

You use this information when logging into the Cognos TM1 Operations Console.

Running Cognos TM1 Operations Console with Cognos TM1 on
Cloud

To run Cognos TM1 Operations Console, you need the related URL and a valid
Cognos TM1 user account, such as the admin account provided in your Cloud
Welcome kit.
1. On your local computer, open a web browser and enter the URL that was

provided for Cognos TM1 Operations Console.
For example, Cognos TM1 Operations Console uses the following URL format:
https://wwwX.cognostm1.ibmcloud.com/pmhub/pm/opsconsole/

Where X is your unique identification number for your cloud system.
2. Enter the required information on the login page.

a. For Adminhost, select data.
b. For Servername, select tm1.
c. For Group, select admin.
d. Enter a valid Cognos TM1 user name and password, such as admin with the

provided password.
3. Click Login.
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Cognos TM1 Operations Console documentation

The following documentation for the Cognos TM1 Operations Console is available
on the IBM Cognos TM1 10.2.0 Information Center:

IBM Cognos TM1 Operations Console Guide (http://pic.dhe.ibm.com/infocenter/
ctm1/v10r2m0/topic/com.ibm.swg.ba.cognos.tm1_ops_console.10.2.0.doc/
c_tm1_inst_ops_console_intro.html).

Cognos TM1 on Cloud with Cognos TM1 Architect
IBM Cognos TM1 Architect is a desktop application that you run in a remote
desktop session with your Cognos TM1 on Cloud system.

To run Cognos TM1 Architect on your cloud system, perform the following steps:
1. Connect to your cloud system with a remote desktop connection.

For more information, see “Connecting to Cognos TM1 on Cloud with a remote
desktop connection” on page 7.

Tip: If the newer Windows Start menu desktop is displayed instead of the
classic desktop view, click the Desktop icon or press the Windows logo key to
toggle to the classic desktop view.

2. Double-click the desktop shortcut for Architect.
3. In Cognos TM1 Architect, expand the TM1 node and double-click the tm1

server node.
4. Enter a valid Cognos TM1 user name and password and then click OK.

Tip: You can log in with the TM1 Server admin account that was provided in
the Cloud Welcome Kit.

5. If the login is successful, the Cognos TM1 server object tree is displayed.

Cognos TM1 Architect documentation

The following documentation for Cognos TM1 Architect is available on the IBM
Cognos TM1 10.2.0 Information Center:
v IBM Cognos TM1 User Guide (http://pic.dhe.ibm.com/infocenter/ctm1/

v10r2m0/topic/com.ibm.swg.ba.cognos.tm1_ug.10.2.0.doc/
c_tm1_ug_pref_intro.html)

v IBM Cognos TM1 Operation Guide (http://pic.dhe.ibm.com/infocenter/ctm1/
v10r2m0/topic/com.ibm.swg.ba.cognos.tm1_op.10.2.0.doc/
c_preface_tm1_ops.html)

Cognos TM1 on Cloud with Cognos TM1 Perspectives
IBM Cognos TM1 Perspectives is an add-in for Microsoft Excel that you run in a
remote desktop session with your Cognos TM1 on Cloud system.

To run Cognos TM1 Perspectives on your cloud system, perform the following
steps:
1. Connect to your cloud system with a remote desktop connection.

For more information, see “Connecting to Cognos TM1 on Cloud with a remote
desktop connection” on page 7.
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Tip: If the newer Windows Start menu desktop is displayed instead of the
classic desktop view, click the Desktop icon or press the Windows logo key to
toggle to the classic desktop view.

2. Double-click the desktop shortcut for Perspectives.
3. If the Microsoft Excel Security Notice dialog is displayed, click Enable Macros

to continue.
4. In Excel, on the TM1 menu, click Connect to log in to the Cognos TM1 Server.
5. Enter the following information in the Connect to TM1 Server dialog:

v For Server ID, select tm1.
v For Client ID, enter your Cognos TM1 user name.
v For Password, enter your Cognos TM1 password.

Tip: You can log in with the TM1 Server admin account that was provided
in the Cloud Welcome Kit.

v Click OK.
6. If the login is successful, a confirmation message is displayed.

Cognos TM1 Perspectives documentation

The following documentation for Cognos TM1 Perspectives is available on the IBM
Cognos TM1 10.2.0 Information Center:

IBM Cognos TM1 User Guide (http://pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/
topic/com.ibm.swg.ba.cognos.tm1_ug.10.2.0.doc/c_tm1_ug_pref_intro.html).

Cognos TM1 on Cloud with Cognos TM1 Performance Modeler
You can run IBM Cognos TM1 Performance Modeler from the remote desktop
connection of your IBM Cognos TM1 on Cloud system.

To run this component:
1. Connect to your Cognos TM1 on Cloud system with a remote desktop

connection.
For more information, see “Connecting to Cognos TM1 on Cloud with a remote
desktop connection” on page 7.

Tip: If the newer Windows Start menu desktop is displayed instead of the
classic desktop view, click the Desktop icon or press the Windows logo key to
toggle to the classic desktop view.

2. Double-click the desktop shortcut for IBM Cognos TM1 Performance Modeler.
3. In the Connect dialog, make sure the IBM Cognos TM1 system URL field

contains the following URL:
https://wwwX.cognostm1.ibmcloud.com/pmpsvc/services

Where X is your unique identification number for your cloud system.
4. Click Log on as, enter your Cognos TM1 user name and password, and then

click Login.
5. In the TM1 Server drop-down list, select the server that you want to log into,

and then click OK.
For example, the default Cognos TM1 server in the cloud system is named tm1.
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Cognos TM1 Performance Modeler documentation

The following documentation for Cognos TM1 Performance Modeler is available
on the IBM Cognos TM1 10.2.0 Information Center:

IBM Cognos TM1 Performance Modeler Guide (http://pic.dhe.ibm.com/
infocenter/ctm1/v10r2m0/topic/com.ibm.swg.ba.cognos.prfmdl_ug.10.2.0.doc/
c_prfmdl_intro.html).

Cognos TM1 on Cloud with Cognos Insight
Use IBM Cognos Insight with your IBM Cognos TM1 on Cloud system to create
managed workspaces where you and your users can analyze, explore, and share
the TM1 data.

Depending on your user role, you run IBM Cognos Insight from either a remote
desktop connection with the cloud system or directly on your local computer.

Running Cognos Insight from the remote desktop session on the
cloud system

Cognos TM1 modelers can run Cognos Insight directly from the remote desktop
session on the cloud system. This approach is intended for layout design of
workspaces.
1. Open your remote desktop protocol (RDP) application and connect to the cloud

system.
For more information, see “Connecting to Cognos TM1 on Cloud with a remote
desktop connection” on page 7.

Tip: If the newer Windows Start menu desktop is displayed instead of the
classic desktop view, click the Desktop icon or press the Windows logo key to
toggle to the classic desktop view.

2. Double-click the desktop short cut for IBM Cognos Insight.

Running Cognos Insight on your local computer

As a Cognos TM1 user, you run IBM Cognos Insight when you work with an
application node inside of IBM Cognos TM1 Applications. If you are running
Cognos Insight for the first time, you are prompted to install it to your local
computer.

Note: IBM Cognos Insight runs only in distributed mode when you run the
program on your local computer and connect to the cloud system.
1. Open Cognos TM1 Applications.

On your local computer, open a web browser and enter the URL that was
provided for Cognos TM1 Applications.
For example:
https://wwwX.cognostm1.ibmcloud.com:443/pmpsvc/

Where X is your unique identification number for you cloud system.
For more information, see “Cognos TM1 on Cloud with Cognos TM1
Applications” on page 13.

2. Open Cognos Insight.
a. In Cognos TM1 Applications, open an application.
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b. Right-click on an application node and select Open Cognos Insight -
Distributed.

c. If you are prompted to install Cognos Insight, follow the prompts to
complete the initial installation of the program.

Cognos Insight documentation

The following documentation for Cognos Insight is available on the IBM Cognos
TM1 10.2.0 Information Center:
v IBM Cognos Insight Tutorial (http://pic.dhe.ibm.com/infocenter/ctm1/

v10r2m0/topic/com.ibm.swg.ba.cognos.coginsight_tut.10.2.1.doc/
c_coginsight_tut_intro_introduction.html).

v IBM Cognos Insight User Guide (http://pic.dhe.ibm.com/infocenter/ctm1/
v10r2m0/topic/com.ibm.swg.ba.cognos.dsk_ug.10.2.1.doc/c_dsk_intro.html).

Cognos TM1 on Cloud with Cognos Analysis for Microsoft Excel
You can use IBM Cognos Analysis for Microsoft Excel to access data from the
Cognos TM1 server on your Cognos TM1 on Cloud system.

To use Cognos Analysis for Microsoft Excel with Cognos TM1 on Cloud, you first
need to download, install, and configure the application. Depending on who needs
to use the application, you might need to distribute or make available the
installation program to other Cognos TM1 users in your organization.

Downloading and installing Cognos Analysis for Microsoft Excel

Installation files for Cognos Analysis for Microsoft Excel are located in your shared
folder on your cloud system.
1. Connect to your shared folder on your cloud system using an FTP application

that supports secure FTP (FTPS).
For more information, see “Copying local files to Cognos TM1 on Cloud” on
page 25.

2. Locate the 32-bit or 64-bit installation programs in the following locations and
download them to your local computer.
v \\data\s\install\cafe\10.2.x.x\win32

v \\data\s\install\cafe\10.2.x.x\win64h

3. Run the installation program on your local computer by double-clicking the
issetup.exe file.

4. Distribute or make available the installation program to other Cognos TM1
users in your organization.

For more information about installing Cognos Analysis for Microsoft Excel, see the
IBM Cognos Analysis for Microsoft Excel, Version 10.2.0, Installation Guide
(http://pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/topic/
com.ibm.swg.ba.cognos.ig_cxr.10.2.0.doc/c_ig_cor_introduction.html)

Connecting Cognos Analysis for Microsoft Excel to Cognos TM1
on Cloud

You must configure your installation of Cognos Analysis for Microsoft Excel before
it can access the Cognos TM1 server on your cloud system.
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1. Use the Options icon in the toolbar of Cognos Analysis for Microsoft Excel to
configure a connection to the Cognos TM1 on Cloud system.

2. Add the address for Cognos Analysis for Microsoft Excel that is provided in
the Cloud Welcome Kit. For example:
https://wwwX.cognostm1.ibmcloud.com/

Where X is your unique identification number for your cloud system.

For more information, see the following topics in the IBM Cognos Analysis for
Microsoft Excel, Version 10.2.0, User Guide:
v Configure connections to IBM Cognos system

(http://pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/topic/
com.ibm.swg.ba.cognos.ug_cxr.10.2.0.doc/t_ug_cxr_mdddmdfrl.html)

v Set up user authentication
(http://pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/topic/
com.ibm.swg.ba.cognos.ug_cxr.10.2.0.doc/t_coi_gt_strtd_enable_signon.html)

v Logging on to an IBM Cognos server
(http://pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/topic/
com.ibm.swg.ba.cognos.ug_cxr.10.2.0.doc/t_coi_gt_strtd_log_on.html)

Cognos Analysis for Microsoft Excel documentation

The following documentation for Cognos Analysis for Microsoft Excel is available
on the IBM Cognos TM1 10.2.0 Information Center:
v IBM Cognos Analysis for Microsoft Excel Installation Guide

(http://pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/topic/
com.ibm.swg.ba.cognos.ig_cxr.10.2.0.doc/c_ig_cor_introduction.html)

v IBM Cognos Analysis for Microsoft Excel User Guide (http://pic.dhe.ibm.com/
infocenter/ctm1/v10r2m0/topic/com.ibm.swg.ba.cognos.ug_cxr.10.2.0.doc/
c_corwelcomeintro.html)

Cognos TM1 on Cloud with Cognos TM1 Mobile Contributor
Use IBM Cognos TM1 Mobile Contributor on your Apple iPad to access your
planning applications that are hosted in IBM Cognos TM1 Applications on your
cloud system.

As a mobile user, you can access all of your planning applications, view
submission status for all approval nodes, and interact with cube views in a grid or
chart format right in the iPad app. You can also change values on the iPad and
submit them back to the plan where the data is updated on the IBM Cognos TM1
server.

Installing and configuring Cognos TM1 Mobile Contributor on the
iPad

As an iPad user, you install Cognos TM1 Mobile Contributor on your iPad directly
from the Apple App Store.
1. On your iPad, open the App Store program and search for “IBM Cognos TM1”

to locate the Cognos TM1 Mobile Contributor app.
2. Install the app.
3. Run Cognos TM1 Mobile Contributor and configure the app so that it can

connect to your Cognos TM1 on Cloud system.
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4. On the welcome screen, tap the Add new connection plus sign (+) button.
5. In the Connect dialog, enter the connection information.

v For Host, enter the address for Cognos TM1 Mobile Contributor that was
provided in the Cloud Welcome Kit.
For example:
wwwX.cognostm1.ibmcloud.com

Where X is your unique identification number for your cloud system.

Note: The prefix of https:// is not required.
v For Connection Name, enter your own text description for this connection.
v For Server Port, set the port to 443.
v For Enable SSL, set the option to ON.

6. Tap Connect to save the configuration and make the connection.
7. If prompted, enter your Cognos TM1 user name and password to complete the

connection.

Cognos TM1 on Cloud with Cognos Command Center agents
You can use IBM Cognos Command Center® to automate your TM1 server.

You can use Cognos TM1 on Cloud to send tasks to Cognos Command Center.
v You can create a task that combines TI processes with file management. For

example, you can create a task that automates a scheduled upload of a data file
to the cloud by using FTPS and runs a TI process that imports the data into
your TM1 on Cloud system. The task can then run a second TI process to export
the results of the first TI process and download the results back to your local
computer.

v You can also use other features of Cognos Command Center. For example, you
can parse log files to look for problems and get alerts.

v You can use Cognos Command Center to bridge on-premises and on-cloud
activities. You can also manage cloud-to-cloud activities.

Attention:

v Because the agent is not a Windows Administrator, you cannot use an agent to
restart the TM1 Server, which runs as a Windows service.

v There is no email server configured. However, other solutions for mailing from
the cloud are available.

Important: When you first use your cloud system, you are provided with a Cloud
Welcome Kit file for each cloud system that you requested. The Cloud Welcome Kit
contains the information that is required to set up an agent in Cognos Command
Center and also to set up a computing resource in the Cognos Command Center
server. For more information, see “Cognos TM1 on Cloud account and system
information” on page 4.

Setting up an agent in the Cognos Command Center server

The agent must be added to the IBM Cognos Command Center and its connection
properties must be configured in order for the Cognos Command Center server to
interact with the agent.
1. In the Cognos Command Center navigation tree, click Setup and Design.
2. On the Setup and Design tab, click Agents.
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3. To create an agent, either click the New icon or right-click the agent item
and click New.

4. Specify a name for the new agent.
5. Specify the following properties:

v Host name For example, wwwX.cognostm1.ibmcloud.com.
v Port For example, 7326.
v Platform For example, Windows.
v Agent user name For example, admin.
v Agent password For example, the fifty-character password included in the

Cloud Welcome Kit..
6. Click Test the Agent to verify that a connection to the agent is working

properly.
Attention: The agent must be running on the host for a test connection to
work.

For more information about creating agents, see Agents (http://pic.dhe.ibm.com/
infocenter/ccc/v10r2m0/topic/com.ibm.swg.ba.cognos.ag_ccc.10.2.0.doc/
c_ag_ccc_agents.html).

Setting up a computing resource in the Cognos Command
Center server

This computing resource type represents an IBM Cognos TM1 server instance.
1. In the Cognos Command Center navigation tree, click Setup and Design.
2. Click Ecosystems.
3. Open an ecosystem. For example, double-click the name of an existing

ecosystem in the navigation pane.
4. In the ecosystem editor window, click the Computing resources tab.

5. Click the Add computing resource icon to add a new computing resource.
A new computing resource editor opens.

6. To add a TM1 computing resource, select TM1 Server from theType drop-down
list.
The TM1 resource attributes are displayed.

7. Configure the following attributes:
v Agent Use the agent that you created in the Setting up an Agent in the

Cognos Command Center server task.
v Home Directory For example, c:\ccc\your_choice.
v Admin host For example, data.
v Server name For example, your_TM1_server name.
v User name For example, your_TM1_user name.
v Password For example, your_TM1_ password.
v CAM namespace name Leave blank.
v Certificate keystore For example, c:\tm1\bin64\ssl\tm1store.
v Certificate keystore password For example, applix.
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For more information, see IBM Cognos TM1 plug-in configuration
(http://pic.dhe.ibm.com/infocenter/ccc/v10r2m0/index.jsp?topic=
%2Fcom.ibm.swg.ba.cognos.ug_ccc_pi_tm1.10.2.0.doc
%2Fc_ug_ccc_pi_tm1_configuration.html).

Cognos Command Center documentation

Documentation for Cognos Command Center is available on the IBM Cognos
Command Center 10.2.0 Information Center (http://pic.dhe.ibm.com/infocenter/
ctm1/v10r2m0/topic/com.ibm.swg.ba.cognos.dsk_ug.10.2.1.doc/c_dsk_intro.html).
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Chapter 3. Cognos TM1 on Cloud modeling tasks

As a modeler for your IBM Cognos TM1 on Cloud system, you should understand
the steps that are unique to the cloud environment, such as uploading and
managing files, and migrating data in your cloud system.

Managing Cognos TM1 Server with Cognos TM1 on Cloud
Some of the management tasks for the IBM Cognos TM1 Server on the cloud
system require assistance from IBM Support.

Stopping and starting the Cognos TM1 Server on the cloud
system

Occasionally you might need to stop and restart the Cognos TM1 Server or other
related service on the cloud system. To do this, contact IBM Support.

Initializing the Cognos TM1 Server on the cloud system

Depending on your cloud environment, you can upload the files for an existing
Cognos TM1 server and load the data into your default TM1 server on your cloud
system. To do this, contact IBM Support.

Managing Cognos TM1 user accounts with Cognos TM1 on Cloud
As a modeler for your IBM Cognos TM1 on Cloud system, you are responsible for
creating and maintaining the necessary TM1 user accounts that are required for
your company.

About this task

You can use IBM Cognos TM1 Architect or IBM Cognos TM1 Performance Modeler
to create and manage Cognos TM1 users and groups for your cloud system.

Procedure
1. To manage user accounts with Cognos TM1 Architect:

a. Run Cognos TM1 Architect in the remote desktop session of the cloud
system.
For details, see “Cognos TM1 on Cloud with Cognos TM1 Architect” on
page 15.

b. Log in to the Cognos TM1 server.
c. Right-click the tm1 node and select Security > Clients/Groups.
d. Use the Clients/Groups tool to manage users.
For more information about managing users and groups with Cognos TM1
Architect, see the IBM Cognos TM1 Operation Guide (http://pic.dhe.ibm.com/
infocenter/ctm1/v10r2m0/topic/com.ibm.swg.ba.cognos.tm1_op.10.2.0.doc/
c_preface_tm1_ops.html).

2. To manage user accounts with Cognos TM1 Performance Modeler:
a. Run Cognos TM1 Performance Modeler in the remote desktop session of

the cloud system.
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For details, see “Cognos TM1 on Cloud with Cognos TM1 Performance
Modeler” on page 16.

b. In the Model Design pane, right-click data.tm1 and select Configure
Security > Define Users and Groups > Users and Groups.

c. Use the ClientGroups tool to manage users.
For more information about managing users and groups with Cognos TM1
Performance Modeler, see the IBM Cognos TM1 Performance Modeler Guide
(http://pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/topic/
com.ibm.swg.ba.cognos.prfmdl_ug.10.2.0.doc/c_prfmdl_intro.html).

Managing files in the Cognos TM1 on Cloud shared folder
You can mange files in your shared folder either remotely or directly within a
desktop session of the cloud. If you have multiple cloud environments, you can
also move files between the shared folders of each environment.

Depending on your local and cloud environment, you can use one or more of the
following methods to manage your files in the shared folder.

Accessing the shared folder from your local computer

If you want to connect to the shared folder from a remote computer, use a file
transfer protocol (FTP) application that supports secure FTP (FTPS). This will allow
you to securely move files between your local computer and the shared folder on
the cloud system.

Use the FTP application with the shared folder address that was provided in the
Cloud Welcome Kit. For example:

wwwX.cognostm1.ibmcloud.com

Where X is your unique identification number for your cloud system.

For more information, see “Copying local files to Cognos TM1 on Cloud” on page
25.

Using the shared folder in a remote desktop session

If you want to access the shared folder from within the remote desktop session on
the cloud system, use the following path:

\\data\s

For example, open the Microsoft Windows File Explorer in the remote desktop
session and enter \\data\s as the path.

Tip: The Windows Explorer tool was renamed to File Explorer in Windows Server
2012.

Moving files between shared folders of multiple cloud
environments

If you want to connect to the shared folder of another Cognos TM1 on Cloud
environment, use the x.x.x.x address that was provided to you.
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For example, to move files between two cloud environments the general steps
include:
1. Start a remote desktop connection to the first cloud environment.
2. Open Microsoft Windows File Explorer in the remote desktop session of the

first cloud environment and enter \\data\s.
3. Open a second instance of File Explorer in the same remote desktop session

and enter the x.x.x.x address for the other cloud environment.
4. Use File Explorer to copy and paste files between the shared folders of these

two cloud environments.

Copying local files to Cognos TM1 on Cloud
Your IBM Cognos TM1 on Cloud system includes a dedicated shared folder for
storing and transferring data files. You can copy files between your local computer
and the cloud system shared folder with a secure file transfer protocol (FTPS)
application.

Before you begin

You must have your Cognos TM1 on Cloud system account information.

You also need an FTP application that supports secure FTP (FTPS) to securely copy
files from your local system to the cloud system.

Important: To ensure that your data is encrypted when transferred, the cloud
system FTP connection is configured to use FTP with Secure Sockets Layer (FTPS).
Make sure to use an FTP application that supports FTPS.

Procedure
1. On your local computer, open your FTP application and enable the option to

use secure FTP (FTPS).
2. Enter the information for the connection:

a. Enter the address for the shared folder on your cloud system.
For example:
wwwX.cognostm1.ibmcloud.com

Where X is your unique identification number for your cloud system.
b. Enter the user name of FileShare and the assigned password for the cloud

shared folder.
3. Use the FTP application to select and move files between your local computer

and the cloud system.
4. Log out of the FTP session and close the FTP application.

Loading and migrating data with Cognos TM1 on Cloud
Migrating data from your development environment to your production
environment with IBM Cognos TM1 on Cloud is a process that requires careful
planning and should be performed in stages. The exact steps for data migration
depend on a number of factors, such as where your development and production
environments are located and what type of data is being moved.

Contact IBM Support for assistance with the following data migration tasks in your
Cognos TM1 on Cloud environment:
v Stopping and restarting your Cognos TM1 Server
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v Performing an initial data migration into your Cognos TM1 on Cloud
production environment.

v Editing Cognos TM1 configuration files.

As a Cognos TM1 modeler, you can perform the following data migration tasks:
v Upload files from your local computer to the shared folder in your

non-production or production cloud system.
v Move files between the shared folders of your non-production and production

cloud systems.
v Manually copy Cognos TM1 Websheet files to the shared folder.

Important: Even though you have full write access to the Cognos TM1 data
directory, you must contact IBM Support to stop and restart your Cognos TM1
Server when copying Cognos TM1 server database files to the data directory.

On an ongoing basis, you can perform the following tasks:
v Use the Transfer tool in IBM Cognos TM1 Performance Modeler to export and

import metadata changes between development and production environments.
For more information, see Importing and transferring data in the IBM Cognos
TM1 Performance Modeler User Guide (http://pic.dhe.ibm.com/infocenter/ctm1/
v10r2m0/topic/com.ibm.swg.ba.cognos.prfmdl_ug.10.2.0.doc/
c_prfmdl_importing_transferring_data.html).

v Use TurboIntegrator processes to load bulk data into your production
environment.
For more information, see IBM Cognos TM1 TurboIntegrator Guide
(http://pic.dhe.ibm.com/infocenter/ctm1/v10r2m0/topic/
com.ibm.swg.ba.cognos.tm1_turb.10.2.0.doc/
c_turbointegratorbasics_n50007.html).
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Appendix. Cognos TM1 on Cloud technical considerations

There are some technical considerations that you should be aware of while using
IBM Cognos TM1 on Cloud.

Cognos TM1 on Cloud with replication and synchronization
IBM Cognos TM1 on cloud does not currently support or test the Cognos TM1
replication and synchronization (rep and sync) feature.

Even though the options for replication and synchronization might appear in the
user interface of components with Cognos TM1 on Cloud, this feature is not
supported in the cloud environment.

Cognos TM1 on Cloud system timezone and clock settings
The IBM Cognos TM1 on Cloud system clock is set to Coordinated Universal Time
(UTC). UTC is a universal time standard that is used across the internet, networks,
online services, and computer servers.

You cannot change the timezone for the Cognos TM1 on Cloud system. Your user
account for the Microsoft Windows desktop environment in the cloud system does
not have sufficient rights to change the timezone.

However, you can add additional clocks in the cloud system that display when
you hover the mouse over the clock in the Windows system tray taskbar. You can
also choose to remove the clock from the Windows taskbar.

For more information about adding additional clocks, search the internet for
“Windows Server 2012 additional clocks”.

Cognos TM1 on Cloud with TurboIntegrator ASCIIOutput and
TextOutput functions

Use a relative path in your TurboIntegrator (TI) processes to export data to your
shared folder on the IBM Cognos TM1 on Cloud system.

The ASCIIOutput and TextOutput TI functions do not work with the output path of
\\data\s on the cloud system. Instead, use ./ to indicate a relative path to the
Cognos TM1 data directory and shared folder on your cloud system.

For example, the following TI code sample does not work on the cloud system:

ASCIIOutput(’\\data\s\prod\test.txt’,test output);

The following code samples do work on the cloud system. These samples write
output to a user-created folder named temp in the data directory:

ASCIIOutput(’./temp/test1.txt’,’test output 1’);

TextOutput(’./temp/test2.txt’,’test output 2’);
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For more information about these TI functions, see ASCII and Text TurboIntegrator
Functions in the IBM Cognos TM1 Reference Guide (http://pic.dhe.ibm.com/
infocenter/ctm1/v10r2m0/topic/com.ibm.swg.ba.cognos.tm1_ref.10.2.0.doc/
c_asciiandtextturbointegratorfunctions_n706d4.html).

Cognos TM1 on Cloud and Cognos TM1 Architect display issue
In some scenarios, running Cognos TM1 Architect or Server Explorer in the
desktop session of the Cognos TM1 on Cloud system causes the expand and
collapse icons (+ and - symbols) in the object tree pane to disappear.

If this display issue happens, you cannot expand the object nodes in the tree and
access your TM1 data objects.

As a workaround, close and reopen Cognos TM1 Architect or Server Explorer to
correct the display.

Cognos TM1 on Cloud and viewing the Message log in Cognos TM1
Architect

Viewing the Message log in Cognos TM1 Architect with Cognos TM1 on Cloud
requires a workaround.

When you click Server > View Message Log, the following error displays: “Error
opening the log file”.

As a workaround, use a text editor, such as Windows Notepad, to open and view
the tm1server.log file from the \\data\s\prod\data\tm1 shared folder location.
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Ottawa, ON
K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

This Software Offering does not use cookies or other technologies to collect
personally identifiable information.
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Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Copyright and
trademark information ” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
v Microsoft, Windows, Windows NT, and the Windows logo are trademarks of

Microsoft Corporation in the United States, other countries, or both.
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